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1 Introduction

This is the Test plan of the DaCoPAn2 Software Engineering project at the Com-
puter Science Department of the University of Helsinki. The DaCoPAn2 project is a
follow-up project for the DaCoPAn project. Its main goal is to improve and expand
the Animator subsystem produced by the DaCoPAn group.

This document is intended to present several aspects of the testing to be performed
on the implemented Animator module. It also contains a test case dealing with
the integration between Analyzer and Animator DaCoPAn modules. The test cases
include those of the original DaCoPAn project and tests for the newly implemented
features.

Section 2 presents the unit test approach for the Animator module.

Section 3 presents the integration testing. It tests the integration of components in-
ternal to the Animator, and the global integration between the two DaCoPAn mod-
ules. Global integration tests the interface between them, that is that the connected
Analyzer output and Animator input are as much error-free in their interaction as
possible.

Section 4 takes care of system testing internally to the Animator module. The
testing of the interaction between different parts of the Animator (mostly the user
interface and the Animation panels) will be explained.

The compliance to the requirements presented in the DaCoPAn2 Requirements Doc-
ument [1] will be checked in section 5.

The format chosen to present the test cases is:

• Each test case will be given an identifier.

• Each test case will define its objective, and/or a textual description if needed.

• The input for the test case and/or the steps to follow to complete it will be
specified as well.

• The expected output or behaviour of the software will be included.

If test cases have numbers in input and output steps, the order of performed steps
should follow this numbering.

2 Unit testing

This section contains an explanation of the internal unit testing approach of the
Dacopan Animator module, using JUnit white box oriented tests.

The DaCoPAn animator unit tests use JUnit, which is a simple framework to
write repeatable tests. It is an instance of the xUnit architecture for unit test-
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ing frameworks. Most of the tests on the different Java classes extend from ju-

nit.framework.TestCase. More information about this class can be found in www.

junit.org/junit/javadoc/3.8.1/index.htm or in junit.sourceforge.net/javadoc/.
It is possible to generate random data that will be used in test cases. One objective
of using JUnit is that it makes possible to run several tests at once. Failures are
detected and highlighted, and there’s no need to check every single result.

Given that the chosen language for the Animator implementation is Java, which is
object-oriented, test cases should check consistency in the use of attributes, check
the behaviour of the objects in all their possible states, and finally test all operations
associated with the object. The unit tests fulfill statement coverage, and the bound-
aries of each methods’ parameters are tested. JUnit test cases are implemented for
all classes which have some meaningful states to be tested – classes which are only
concerned with drawing graphics will be tested in system testing. Object interaction
testing will be presented under integration and system testing in further sections.

The managing of the JUnit test cases and their results, and the running of the
tests is done using the RITA software, developed at the Department of Computer
Science of the University of Helsinki. RITA is a graphical testing tool which is
able to visualize the structure of software under testing and verifying that the de-
sired level of coverage is accomplished by the tests. The RITA version used dur-
ing testing is 0.68. The RITA software and user manual is found under the link
http://www.cs.helsinki.fi/u/tevanlin/softat.html and the RITA project home-
page is http://www.cs.helsinki.fi/group/rita.

3 Integration testing

In this section, the test cases that verify the correct integration between different
DaCoPAn components, both globally and locally to the Animator are described.

3.1 Local integration

This section presents the local integration testing internal to the Animator subsys-
tem. It provides a test case which checks the local integration between the Pro-

tocolEventsReader and DataView classes. It is assumed that both classes have
passed their unit tests before this test is run.

Test case 1 – ProtocolEventsReader and Dataview

• OBJECTIVE
Test local integration between ProtocolEventsReader and Dataview:

Most of the possible errors in the Animator could come from the reading of the
protocol interchange data from PEFs into the animator data structures. Errors
in that scope should show error messages to the user, and reject erroneous
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PEFs. This test case should check the integration between DataView and
ProtocolEventsReader. The loaded PEF must be a correct DTD compliant
document, then the information contained in it must be consistent. Tests that
are completed:

– The system must resolve the path to the XML DTD.

– The document must be valid (correct XML version and such.)

– The DOCTYPE specified in the PEF should be correct.

– Hosts, flows, links, layers, variables and units must be present. Protocols
must be present inside layer tags.

– The information contents must be read without errors into the data struc-
tures.

– The protocol exchange contents must be consistent: each unit should
have an end tag (received or lost), variables used in units should have
been declared in the variables area and constants should have an ”owner”
(link, host or protocol).

• INPUT/ STEPS
Run XMLProtocolEventsReaderTestCase.java as a JUnit test.

• EXPECTED OUTPUT/ BEHAVIOUR
No errors or failures should be collected.

3.2 Integration between Animator and Analyzer

Integration between the DaCoPAn Analyzer and Animator modules relies essentially
on the format and contents of the Protocol Events Files generated by the Analyzer
and read by the Animator. The compliance of any PEF to the DTD is checked
in the XMLProtocolEventsReader class, and written according to it by the Ana-
lyzer. Some control of the consistency of the data is also achieved by the XMLProto-
colEventsReader class, that may reject the use of any incomplete or contradicting
information contained in any PEF.

Test case 2 – Analyzer generated PEFs compliance to the

Animator XML reader

• OBJECTIVE
Test that Animator can read Analyzer generated PEFs correctly.

ProtocolEventsReader should be tested with some PEFs created by the An-
alyzer module. The information present in the PEF should be correctly loaded
into the data structures. Tests should be similar to those made in Test case 1.
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• INPUT/ STEPS

– Run the Animator module and load the Analyzer generated PEF.

– Visually, compare the visualized data interchange information with the
information present in the PEF.

• EXPECTED OUTPUT/ BEHAVIOUR
No errors or failures should be collected on loading, meaning that the loaded
PEF conforms to the XML DTD. The packet interchange data must be the
same than the one contained in the PEF created by the Analyzer module.

4 System testing

This section presents test cases that check the interaction of different parts of the
Animator, after each unit has passed its correspondent unit test, and the integration
tests have been passed. The tests cases are black box tests. They require that the
Animator’s settings are in their defaults, i.e. the user should not have saved any
settings before running these tests. It is preferable to rebuild Animator software
between test runs. If it is not stated otherwise, the user should select a valid PEF
file that has data in it.

Test case 3 – Settings and user interface visualization in MSC.

• OBJECTIVE
Test local integration between settings and user interface visualiza-

tion in MSC animation type

• INPUT/ STEPS
Make changes in the settings and check that animation changes as supposed.
For that, run the Animator module and load a correct PEF using the “open”
command. Make sure, that the Animator is on MSC mode and on network
layer. Press “Play” in order to have some packets on screen. Then press the
“Settings” button or select the Settings menu item from the upper menu bar.

1. Select “Network”.

2. Select both variables and press “Apply”.

3. Select some protocol header fields, press “Accept”, start animation and
re-select settings.

4. De-select one variable and press “Apply”.

5. De-select some protocol header fields and press “Apply”.

6. De-select timestamp column and all variables and press “Apply”.
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7. Select some variables and press “Apply”.

8. Select timestamp column and press “Apply”.

9. Select stepping settings and make sure that it is on nonlinear time axis
mode

10. Increase font size and press “Apply”.

11. Decrease font size and press “Apply”.

12. Increase minimum stepping and press “Apply”.

13. Decrease minimum stepping and press “Apply”.

14. Decrease maximum stepping and press “Apply”.

15. Increase maximum stepping and press “Apply”.

16. Increase progress speed, press “Accept”, start animation and re-select
settings.

17. Switch to linear time axis mode and press “Apply”.

18. Reduce time scale and press “Apply”.

19. Increase time scale and press “Apply”.

20. Reduce visual scale and press “Apply”.

21. Increase visual scale and press “Apply”.

22. Select performance settings.

23. Reduce refresh delay, press “Accept”, start animation and re-select set-
tings.

24. Increase refresh delay, press “Accept”, start animation and re-select set-
tings.

• EXPECTED OUTPUT/ BEHAVIOUR
The visualization should behave accordingly to the changes made in the set-
tings:

1. Network variables and protocol header fields should appear. The times-
tamp column should be selected by default.

2. Both variables should appear next to the first packet and the minimum
stepping should increase accordingly.

3. Protocol header information should appear on top of the unit line. For
dropped packets the placement of the dropping cross should change such
that all header fields fit above it.

4. Minimal minimum stepping should decrease and de-selected variables
should disappear.

5. De-selected header fields should disappear and dropping crosses should
move.
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6. Timestamp and variables columns should disappear, but the minimum
stepping should not decrease as it should be on its minimum.

7. Variables columns should appear and if more than one variable is selected,
the minimum stepping should also increase.

8. Timestamp columns should appear possibly shrinking variable columns.

9. The “Stepping settings” should appear.

10. Text in the animation panel should become bigger and the minimum
stepping should increase so that text will not overlap.

11. Text in the animation panel should become smaller, but the minimum
stepping should stay the same. Minimal minimum stepping should, how-
ever, decrease.

12. The distance between consecutive lines in the animation panel should
increase, and also the minimal maximum stepping should increase.

13. The distance between consecutive lines in the animation panel should
decrease, but the text should not overlap. Also the minimal maximum
stepping should decrease.

14. The gradients of some lines in the animation panel should degrease.

15. The gradients of some lines in the animation panel should increase.

16. Animation should progress faster.

17. Linear time axis mode should become visible and the animation should
be re-drawn in linear time axis mode.

18. Animation time goes faster.

19. Animation time goes slower.

20. The angle of the arrow representing a unit is smaller, so more units are
drawn on the screen.

21. The angle of the arrow representing a unit is larger, so less units are
represented on the screen.

22. Performance settings should become visible.

23. Each step is smaller, so the visual flow of the animation is smoother.

24. Each step is larger, so the visual flow of the animation is less smooth.

Test case 4 – MSC buttons and encapsulation

• OBJECTIVE
Test MSC buttons, and test encapsulation invocation.

• INPUT/ STEPS
Load some valid PEF file and make sure that the Animator is on MSC mode.
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1. Press “Play”.

2. Press “Pause”.

3. Press “Rewind”.

4. Press “Fast forward”.

5. Press “Rewind” and then press “Step forward”.

6. Press “Fast forward” and then press “Step backward”.

7. Press “Rewind” and then press “Step backward”.

8. Press “Fast forward” and them press “Step forward”.

9. Press layer selection buttons.

10. Press “Show encapsulation”button (in Unit flow area) for a given transfer
unit (when enabled).

11. Drag progress line past the drawing area windows top or bottom borders.

• EXPECTED OUTPUT/ BEHAVIOUR

1. Packet interchange should begin.

2. Packet interchange should be paused.

3. Packet interchange should rewind to the beginning.

4. Packet interchange should fast forward to the end.

5. Packet interchange should step once forward.

6. Packet interchange should step once backward.

7. Nothing should happen.

8. Nothing should happen.

9. Shown layer should change in the MSC.

10. The ENC panel should appear instead of MSC panel, showing the en-
capsulation tree for the chosen transfer unit. It shows units that are
encapsulated inside the chosen unit, if there are any, as well as units from
upper layers in which the chosen unit is encapsulated. The chosen trans-
fer unit should be highlighted with a red line. A partial unit means that
not all the units that are encapsulated in underlying layers are shown. A
left or right sibling of a unit on the left or right part of the shown units
means that there are other previous or later units in the same layer.

11. Animation should scroll.
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Test case 5 – Settings and user interface visualization in TSC.

• OBJECTIVE
Test local integration between settings and user interface visualiza-

tion in the TSC animation type

• INPUT/ STEPS
Make changes in the settings and make sure that animation changes accord-
ingly. For that, run the Animator and load a special PEF with SACK variables
using the “open” command. Change animation mode to TSC and press “Fast
forward”. Then press the “Settings” button or press Settings → Settings.. in
the menu bar.

1. Select “Graphical elements”.

2. De-select all graphical elements and press “Apply”.

3. Re-select some graphical elements and press “Apply”.

4. Re-select all graphical elements and press “Apply”.

5. Change the colors of some graphical elements and press “Apply”.

6. Select “Animation settings”.

7. Increase animation speed, press“Accept”, press“Rewind”and press“Play”.

8. Go back to settings, decrease animation speed, press “Accept” and press
“Play”.

9. Go back to settings, deselect “Relative sequence number” and press “Ap-
ply”.

10. Select “Relative sequence number” and press “Apply”.

11. Go back to settings and select “Notices”.

12. Add new notices such that they should appear in animation and press
“Apply”.

13. Disable some of the notices and press “Apply”.

14. Go to “Animation settings”, increase “Notice delay”, press “Accept” and
press “Play”.

15. Decrease “Notice delay”, press “Accept” and press “Play”.

16. Select “Unit variables”.

17. Select all unit variables and press “Apply”.

18. De-select all unit variables and press “Apply”.

• EXPECTED OUTPUT/ BEHAVIOUR

1. TSC settings with graphical elements checkboxes should appear.
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2. All graphical elements in the drawing area and legend table should dis-
appear.

3. Selected graphical elements should re-appear in the drawing area and
legend table.

4. All graphical elements should appear in the drawing area and legend
table.

5. The colors of the graphical elements should change in the drawing area
and legend table.

6. Animation settings dialog should appear.

7. The Animator should play animation at increased speed.

8. The Animator should play animation at decreased speed.

9. Sequence numbers should become absolute.

10. Sequence numbers should become relative.

11. Notices dialog should appear.

12. Notices should appear in the notice bar.

13. Disabled notices should disappear from the notice bar.

14. The Animation should wait a bit longer when a notice appears.

15. The Animation should not wait as long when a notice appears.

16. The unit variables dialog should appear.

17. All unit variables should appear in the Unit info panel.

18. All unit variables should disappear from the Unit info panel.

Test case 6 – TSC buttons and sliders

• OBJECTIVE
Test TSC buttons and sliders.

• INPUT/ STEPS
Load a PEF with multiple flows in it using File → Open file..

1. Change to the TSC view.

2. Press “Play”.

3. Press “Pause”.

4. Press “Rewind”.

5. Press “Fast forward”.

6. Press “Rewind” and then press “Step forward”.

7. Press “Step backward”.
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8. Change host from “A” to “B” and press “Fast forward”.

9. Change flow and press “Fast forward”.

10. Select some packet via clicking it with the mouse.

11. Decrease “X-scale”, little by little, all the way to left end.

12. Decrease “Y-scale”, little by little, all the way to left end.

13. Increase “X-scale” a little.

14. Increase “Y-scale” a little.

15. Press “Play”.

16. Press “Pause” and press “Fast forward”.

• EXPECTED OUTPUT/ BEHAVIOUR

1. An empty TSC view should appear.

2. The Animator should start playing the animation.

3. The animation should stop.

4. The animation should rewind back to the start.

5. The animation should go to the end and the whole animation should be
on screen.

6. The first segment in animation should be visible and selected.

7. The first segment should disappear.

8. The view should change to be seen from other host.

9. The view should change to other flow.

10. The selected packet should be boxed with red box and its information
should appear in the Unit info panel.

11. Time scale should decrease, but the selected packet should remain visible
during resizing.

12. Sequence number scale should decrease, but the selected packet should
remain visible during resizing.

13. Time scale should increase and the selected packet should remain visible.

14. Sequence number scale should increase and the selected packet should
remain visible.

15. Animation should follow the latest packet, so that it is always visible.

16. Animation should go to the end and the last packet should be selected
and visible.
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Test case 7 – Localization

• OBJECTIVE
Testing localization in the different animation features: That is, test-
ing that the program can be localized to any language.

• INPUT/ STEPS
Change the dacopan.properties file in the main/fi/helsinki/dacopan di-
rectory so that all the localized strings are replaced by the character “X”. Run
the Animator module, and select English in Settings → Language, in the up-
per menu bar. Run different test cases such as Test cases 3 and 4. Browse
through all different panels and windows available in the program. Set on all
possible textual information to be shown in the animations and display the
animations.

• EXPECTED OUTPUT/ BEHAVIOUR
No error messages about missing localization strings should emerge. All the
text visible in all the user interface elements should be displayed as “X”.

Test case 8 – Help menu

• OBJECTIVE
Test help menu invocation.

• INPUT/ STEPS
Run the Animator module, and press the “Help” button in the upper menu
bar.

• EXPECTED OUTPUT/ BEHAVIOUR
The Help menu should be shown, offering different kinds of explanations about
the use of the DaCoPAn Animator software.

Test case 9 – Scenario and explore modes

• OBJECTIVE
Test scenario and explore modes.

• INPUT/ STEPS
Run the Animator module, load some PEF and make sure that the Animator
is on MSC view. Change to scenario mode using the menu bar radio button
Animation → Scenario mode. Play animation, press encapsulation button
and add some notices. Select “Recording mode” from scenario play list and
press “Record start”. Press “Play”, wait and press “Pause”. Press “Record
end”. Drag progress line such that UFO panel has some active unit. Press
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“Encapsulation”and press“Insert Encapsulation” from scenario play list. Press
“Settings” button or select Settings → Settings.. and change some settings.

Save scenario using File → Save as.. button from menu bar. Re-start the
Animator and load a saved scenario file. Play it. Change to explore mode.

• EXPECTED OUTPUT/ BEHAVIOUR
The scenario should be played as it was saved and notes should appear when
they were created. Settings should be as they were when the scenario was
saved. The user should be able to change back to explore mode to explore
animation freely as described in other test cases.

Test case 10 – Time panel

• OBJECTIVE
Test Time panel visualization.

• INPUT/ STEPS
Run the Animator module, load a valid PEF, make sure the Animator is on
MSC mode and press “Play” or “Step forward”.

• EXPECTED OUTPUT/ BEHAVIOUR
The Time panel should show the actual time of the animation, that is the
timestamp corresponding to the position of the progress line shown in the
MSC animation panel.

Test case 11 – Note panel in MSC

• OBJECTIVE
Test Note panel in MSC animation type.

• INPUT/ STEPS
Run the Animator and load a valid PEF. Edit some text on the Note panel,
and press the Save note button.

1. Press “Rewind” and “Play” button.

2. When a note is shown, press“Edit note”, edit note and then press“Rewind”
and then “Play”

3. When a note is shown, press “Delete note”, then press “Rewind” and then
“Play” buttons.

• EXPECTED OUTPUT/ BEHAVIOUR
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1. The note should be saved and later shown for the same layer and at the
same timestamp. When the same timestamp is reached during animation,
the note must be shown.

2. The note should be saved and shown with its edited form.

3. At the timestamp when the old note was, no note should be shown.

Test case 12 – Note panel in TSC

• OBJECTIVE
Test Note panel in TSC animation type.

• INPUT/ STEPS
Run the Animator and load a valid PEF. Press “Fast forward” and choose
some packet.

1. Change to “Notes” tab at panel in lower right corner.

2. Write a new note to this packet by pressing “Add”.

3. Select another packet from animation and write a new note to that also.

4. Press “Rewind” and “Play” and watch the whole animation.

5. Select another note and edit it by pressing “Edit”.

6. Press “Rewind” and “Play” and watch the whole animation again.

7. Select another note and remove it by pressing “Delete”. Remove also
other notes and press “Rewind” and “Play” and watch the animation.

• EXPECTED OUTPUT/ BEHAVIOUR

1. Notes tab should appear with “Add”, “Edit” and “Delete” buttons.

2. Note should be visible in the Note panel.

3. A new note should be visible ain the Note panel.

4. Notes should appear when corresponding packets are active.

5. Edited note should be visible at Note panel.

6. New notes should appear when corresponding packets are active.

7. No notes should be visible this time.



14

Test case 13 – Visibility of packets in UFO

• OBJECTIVE
Test visibility of packets in the UFO animation.

• INPUT/ STEPS
Run the Animator and load a valid PEF. Ensure that the Animator is in
MSC/UFO mode. Choose a slow progress line speed in the settings.

1. Move the progress line in the MSC animation with the mouse to several
different positions where there are as many transpiring events as possible.

2. Select the unit id header variable to be shown on top of the unit line in
the MSC settings. Move the progress line near several different positions
where new units are sent.

• EXPECTED OUTPUT/ BEHAVIOUR

1. The units visible in the UFO panel should be drawn so that their positions
correspond to the positions where the progress line intersects them in the
MSC panel. The units’ width should be as narrow as possible to ensure
that as many units can be drawn next to each other as possible.

2. The unit corresponding to the nearest sent unit should be highlighted so
that it clearly stands out from the other units. The id value seen in the
UFO panel should be the same as that of the most recently sent unit in
the MSC.

Test case 14 – Save all settings and restore defaults

• OBJECTIVE
Test saving all settings and restoring defaults.

• INPUT/ STEPS
Start the Animator and load some PEF file. Go to settings from the menu
bar Settings → Settings.. Change settings for MSC and TSC and press “Save
all settings”. Quit animator. Start the Animator again and load some PEF.
Press “Restore defaults”.

• EXPECTED OUTPUT/ BEHAVIOUR
Settings should be as they were before the Animator was re-started. “Restore
defaults” should restore settings as they were before changing them in the first
place.
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Test case 15 – TSC and PEFs without TCP layer or sequence

numbers

• OBJECTIVE
Test TSC mode compatibility with PEFs that does not have neces-

sary information

• INPUT/ STEPS
Start the Animator and load a PEF that does not have TCP layer information
in it. Change to TSC mode. Load another PEF that does not have sequence
numbers at TCP layer. Change to TSC mode.

• EXPECTED OUTPUT/ BEHAVIOUR
TSC should report that this file does not have a TCP layer in it and thus it is
not possible to use TSC mode. TSC should report that this file does not have
sequence numbers in it and thus it is not possible to use TSC mode.

Test case 16 – Text visibility

• OBJECTIVE
Test the visibility of chosen text and background color combinations.

• INPUT/ STEPS
Start animator and load a PEF file. Ensure that the chosen language is En-
glish.

• EXPECTED OUTPUT/ BEHAVIOUR
All texts—especially the text “Message Sequence Chart” below the toolbar—
should be readable.

Test case 17 – Animation panel

• OBJECTIVE
Ensure that all extra area is given to the actual animation panels

when resizing the main window.

• INPUT/ STEPS
Start the Animator and load a PEF file. Enlarge the main window using the
mouse. Repeat after changing the animation mode from MSC to TSC.

• EXPECTED OUTPUT/ BEHAVIOUR
When the size of the window becomes larger, the size of the main animation
panel should be enlarged and the size of the secondary panel on the right side
of the window should remain the same.
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Test case 18 – Opening animator files

• OBJECTIVE
Test that the Open File dialog shows all supported file types by

default.

• INPUT/ STEPS
Start the Animator. Click the “Load file” button in the toolbar. Go to a
directory where there are pef files, scenario files, and other files.

• EXPECTED OUTPUT/ BEHAVIOUR
All pef and scenariofiles should be visible in the dialog. No other files should
be visible.

Test case 19 – Animation readability at the auditorium

• OBJECTIVE
Test animation readability at auditorium.

• INPUT/ STEPS
Go to the auditorium, start the Animator and use a data projector to show
it. Load some PEF file and use both MSC and TSC animation types. Change
font size in MSC and colors at TSC if needed.

• EXPECTED OUTPUT/ BEHAVIOUR
Animation should be visible to the back-most row at auditorium. Font size
chooser and color chooser should help.

5 User requirements

Following is a complete list of user requirements/functions and tests that validate
them. All user requirements are presented in the DaCoPAn2 Requirements specifi-
cation document.

Req. Tests

A1 Test cases 6 and 5
A2 Test case 5
A3 Test case 5
A4 Test case 6
A5 Test case 61

A6 Test case 5
continued on next page
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Req. Tests

A7 Test case 5
A8 Test case 5
A9 Test case 5
A10 Test case 12
A11 Test case 6
B1 Test case 4
B2 Not implemented
B3 Test case 3
B4 Test case 3
B5 Test case 3
B6 Test case 3
B7 Test case 3
B8 Test case 3
B9 Test case 4
B10 Test case 4
B11 Test cases 3 and 4
B12 Not implemented
B13 Test case 3
B14 Test case 3
B15 Test case 3
C1 Not implemented
C2 Not implemented
D1.1 Test case 13
D1.2 Test case 13
D1.3 Not implemented
D2 Test case 13
E1 Test case 14
E2 Test cases 3 and 5
F1 Test case 16
F2 Test case 17
F3 Test case 18
F4 Test case trivial
F5 Test case 3
F6 Test case 7
F7 Test case 19
F8 Non-functional requirement
F9 Test case 2

1Implementation of functions A5.1 and A5.2 has been changed from requirements specification,

please refer to Design document.
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